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Overview 
Stellar DBX To Windows Live Mail Converter converts Microsoft Outlook Express (DBX) 

files to Windows Live Mail (EML) file. The application scans and converts a single or mutiple 

DBX files. After scanning, the software shows the preview of mails.  

Key Features of Stellar DBX To Windows Live Mail Converter 

• User friendly and secure software. 

• Converts .Microsoft Outlook Express (DBX) files to Windows Live Mail (EML) file. 

• Find feature to search for Microsoft Outlook Express (DBX) files. 

• Provides preview of mails. 

• Log Report. 
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Installation Procedure 
Before installing the software, check that your system meets the minimum system requirements: 

Minimum System Requirements 

• Processor: Pentium Class 

• Operating   System: Windows XP / Windows Vista / Windows 7( 32 bit ) 

• Memory: Minimum 1 GB 

• Hard Disc: 50 MB of Free Space 

To install the software, follow these steps. 

• Double-click StellarDBXToWindowsLiveMailConverter.exe executable file to start 

installation. Setup - Stellar DBX To Windows Live Mail Converter dialog box is displayed.  

• Click Next. License Agreement dialog box is displayed. 

• Choose I accept the agreement option. Next button will be enabled. Click Next. Select 

Destination Location dialog box is displayed. 

• Click Browse to select the destination path where the setup files will be stored. Click 

Next. Select Start Menu Folder dialog box is displayed. 

• Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks 

dialog box is displayed. 

• Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is 

displayed.  

• Review the entries. Click Back if you want to change them. Click Install to start 

installation. The Installing window shows the installation process. 

• After completing the process, Completing the Stellar DBX To Windows Live Mail 

Converter Setup Wizard window is displayed. Click Finish. 
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 Clear Launch Stellar DBX To Windows Live Mail Converter check box to stop automatic 

launch of software.  
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Launching the Software 
You can use any of the following methods to start Stellar DBX To Windows Live Mail 

Converter:  

• Click Start -> Programs -> Stellar DBX To Windows Live Mail Converter -> Stellar 

DBX To Windows Live Mail Converter.  

• Double click icon on the Desktop.  

• Click Stellar DBX To Windows Live Mail Converter icon in Quick launch.  
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User Interface 

 

Stellar DBX To Windows Live Mail Converter software has a very easy to use Graphical User 

Interface. The user interface contains features required for conversion. 

 

After launching the program, you will see the main user interface as shown below: 

 

 
 

 

The user interface contains menus and buttons that lets you access various features of the 

software with ease.  
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Menus 

File 

Open DBX File 

Use this option to select .dbx 

file, identity folder 

 

Save DBX File 

Use this option to save 

converted mails after 

scanning. 

 

Exit 

Use this option to exit the 

application. 

 
 

File Menu 

View 

 
 

View Menu 

View Log  

Use this option to make log window 

visible/invisible. 

 

Toolbar  

Use this option to make toolbar visible/invisible. 

 

Status Bar 

Use this option to make Status bar 

visible/invisible. 

Tools 

 

Save Log 

Use this option to save log report. 

 

Clear Log 

Use this option to clear log window of log 

details. 

 
 

Tools Menu 
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Activation 

Use this option to activate the product after purchasing. 

Help 

 

 

 

 
 

Help Menu 

  

Help Topics 

Use this option to see user 

help guide. 

 

Order Stellar DBX To 

Windows Live Mail 
Converter 

Use this option to buy 

Stellar DBX To Windows 

Live Mail Converter. 

 

View Support Section 

Use this option to visit 

support page of 

stellarinfo.com. 

 

View Knowledgebase  

Use this option to visit 

knowledgebase articles of 

stellarinfo.com. 

 

Submit  a Ticket 

Use this option to submit 

enquiry to stellarinfo.com. 

 

Updates 

Use this option to update 
Stellar DBX To Windows 

Live Mail Converter 

   

About Stellar DBX To 

Windows Live Mail 

Converter 
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Use this option to read 

information about the 

software.   
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Buttons 

The user interface of Stellar DBX To Windows Live Mail Converter has the following buttons: 

 

Open DBX File: 

 

 

Click this button to open Select DBX File dialog box. 

Save DBX File: 

 

 

After scanning, click this button to go through the process of 

saving converted mails.  

Stop:  

 

 

Click this button to stop the scanning process. 

Help: 

 

 

Click this button to access User Guide if you face any issue 

while using the product. 

Updates:  

 

 

Click this button to check for both latest minor and major version 

available online.  

Order: 

 

 

Click this button to go through the purchasing process. 

About:  

 

Click this button to know the version of the software, operating 

system it supports, service pack number of the operating system, 

etc. 



  

11 

 
 

 

How to Order? 
The software can be purchased by making payments online. Please visit 

http://www.stellarinfo.com/email-tools/dbx-windowslivemail-converter/buy-now.php  for more 

information and to place an order. 

Alternatively, if the demo version is installed then you can click the Buy Now link in the Purchase 

dialog box. To get Purchase dialog box, you have following two options: 

1. Click Order button on the application tool bar. 

2. Select Order Stellar DBX To Windows Live Mail Converter option in Help menu on the 

menu bar. 

Select any of the methods given above to go further with the purchasing process. 

Once the order is confirmed, a pre-paid serial # will be sent through e-mail, which would be 

required to activate the software. 

http://www.stellarinfo.com/email-tools/dbx-windowslivemail-converter/buy-now.php
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How to Register? 
The demo version of Stellar DBX To Windows Live Mail Converter can be downloaded from 

the Stellar web site. This demo version is just for evaluation purpose and must be eventually 

registered to use the full functionality of the software. Software can be registered after receiving 

the key. To register the demo application, follow these steps: 

 

• Start the demo version of the application.  

• Select Activate Stellar DBX To Windows Live Mail Converter option from Activate 

menu on the menu bar. Activation dialog box is displayed. 

 

• Enter the user name and activation code, received by mail, after purchasing the software. 

• A confirmation message is displayed if a valid code is entered.  

• Click OK. 
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How to Update? 
There are periodical software updates for Stellar DBX To Windows Live Mail Converter. The 

software updates should be done to keep the software up-to-date. The updates can be a newly 

added functionality, a new feature, a new service or any other information that can be important 

for improvement. Update option in the application is capable of checking for the latest updates. 

This will check for both latest minor and major version available online. You can easily download 

minor version through the update wizard. However, the major version, if available, has to be 

purchased. While updating the software, it’s recommended to close all the running programs. 

Note that demo version can not be updated.  

To update the application, follow these steps: 

• Click on Update Wizard button in application tool bar. Update Wizard is displayed. 

• Click Next. A busy timer shows that updates are being searched. If it finds any new 

version, a message indicates the availability.  

• If a message is displayed that no updates are available, Click Cancel to close the wizard. 

• Click Next. The software will start downloading the update files from the server. When 

the process is complete, the software will upgrade to the latest version.  
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How to Uninstall the Software? 
Stellar DBX To Windows Live Mail Converter can be removed either using Uninstall Stellar 

DBX To Windows Live Mail Converter program in the software or from Add/Remove programs 

in the Control Panel. 

To uninstall the application using Uninstall Stellar DBX To Windows Live Mail Converter:   

Click Start -> All Programs -> Stellar DBX To Windows Live Mail Converter -> 

Uninstall Stellar DBX To Windows Live Mail Converter. Follow on screen instructions to 

completely remove the software, including registry entries from your computer.  

To uninstall the application using Control Panel: 

Click Start -> Control Panel -> Add Or remove Program. Select Stellar DBX To 
Windows Live Mail Converter entry from the displayed list and click Change/Remove. 

Follow on screen instructions to completely remove the software as well as registry entries 

from your computer. 
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Stellar Support 
Our Technical Support professionals will give solutions for all your queries related to Stellar 

products.  

You can either call us or go online to our support section at http://stellarinfo.com/support/. 

For price details and to place the order, click  http://www.stellarinfo.com/email-tools/dbx-

windowslivemail-converter/buy-now.php. 

Chat Live with an Online technician at http://stellarinfo.com/support/. 

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb/. 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php. 

E-mail to Stellar Support at support@stellarinfo.com. 

 

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 
USA (Tollfree- Pre Sales Queries)USA 

(Post Sales Queries) 
UK (Europe) 

Australia & Asia Pacific 
Netherlands Pre & Post Sales Support 

Worldwide 
Skype Id 

Email Orders  

+1-877-778-6087 
+1-732-584-2700 
+44-203-026-5337 
+61-280-149-899 
+31-208-111-188 
+91-921-395-5509 
stellarsupport 
orders@stellarinfo.com  

http://www.stellarinfo.com/support/
http://www.stellarinfo.com/email-tools/dbx-windowslivemail-converter/buy-now.php
http://www.stellarinfo.com/email-tools/dbx-windowslivemail-converter/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com.
mailto:orders@stellarinfo.com
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Select Single DBX File 
To select single DBX file to be converted,  

• Choose Convert / Migrate single DBX file to Windows Live Mail in Select DBX File 
dialog box as shown below: 

 
 

 

Select DBX File dialog box is opened when you  

 

• Launch the application. 

• Choose Open DBX File option in File menu. 

• Click Open DBX File  button on the toolbar. 

 

Click Select DBX button and locate DBX file in Open dialog box. 

After selection, Start Conversion button is enabled.  

 

Click Start Conversion button to start the scanning process.  
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Select Multiple DBX File/Identity 
To select multiple DBX files to be converted,  

Choose Convert / Migrate entire DBX Identity to Windows Live Mail in Select DBX File dialog 

box as shown below: 

 

 

  
Select DBX File dialog box is opened when you  

 

• Launch the application 

• Choose Open DBX File option in File menu. 

• Click Open DBX File  button on the toolbar. 

 

Click Select Identity Folder button in Select DBX File dialog box and locate Identity Folder in 

Browse dialog box. 

The software displays the list of DBX files found in the selected identity folder as shown below: 
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Click Start Conversion button to start the scanning process.  

 

 

The default location of Identity Folder on Windows XP system is -> C:\Documents and 

Settings\Administrator\Local Settings\Application Data\Identities\.....  
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Search DBX Files 
To search for DBX file, 

Click Find DBX button in Select DBX File dialog box. Find DBX dialog box opens as shown here: 

 

 
 

Select drive to be searched for DBX files in Look in drop down box and click Start button. The 

application starts searching for DBX files and displays list of files found after finishing the search. 
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Select desired DBX file and click OK. 

Click Start Conversion button in Select DBX File dialog box to start conversion process. 
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Preview Mail Items 
After scanning is completed successfully, the application displays mailbox folders in left pane of 

the user interface. Click on any folder to see its mails in upper right pane. To see content of 

desired mail, click on it in upper right pane. The content is displayed in lower right pane as shown 

below. 
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Save Converted Mails 
To save converted mails, 

• After scanning, click Save Mails button on the toolbar or select Save Mails option in the 

File menu. 

• Save Files dialog box opens as shown below. 

 

 
 

• Click Browse button. Browse For Folder dialog box opens. Select location for saving 

EML file and click OK. 

• Click OK. 

• The converted mails will be saved as .eml file. 
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View and save Log Report  
During and after completion of scanning process, you can see log details in bottom window of 

Stellar DBX To Windows Live Mail Converter. The Log Report window displays beginning of 

the process, end of the process, name of the file etc. during running of the process. With Stellar 

DBX To Windows Live Mail Converter, you can save Log Report to analyze recovery process 

at a later stage.   

 

 
To save log details,  

• Click on Tools menu on the menu bar.  

• Select Save Log option. 

• Browse for location in Save As dialog box to save log report at desired location. 
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Copyright 
Stellar DBX To Windows Live Mail Converter software, accompanied user manual and 

documentation are copyright of Stellar Information Systems Ltd., with all rights reserved. Under 

the copyright laws, this user manual cannot be reproduced in any form without the prior written 

permission of Stellar Information Systems Ltd. No Patent Liability is assumed, however, with 

respect to the use of the information contained herein. 

 

Copyright © 1995-2012 by Stellar Information Systems Ltd. INDIA 
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Disclaimer 
The Information contained in this manual, including but not limited to any product specifications, 

is subject to change without notice. 

 

STELLAR INFORMATION SYSTEMS LTD PROVIDES NO WARRANTY WITH REGARD TO 

THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 
EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR 

FITNESS FOR ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING 

STELLAR INFORMATION SYSTEMS LTD ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL 
ERRORS OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE 

PRODUCT AND THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION SYSTEMS 

LTD., BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY 

DAMAGES, WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF 
OR IN CONNECTION WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED 

HEREIN OR THE USE THEREOF. 
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License Agreement 
Stellar DBX To Windows Live Mail Converter  

Copyright © 1995-2012 by Stellar Information Systems Ltd. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar DBX To Windows Live Mail 

Converter. 

 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing 

this software, unless you have a different license agreement signed by Stellar Information 

Systems Ltd. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, 

distribute or use any copy of Stellar DBX To Windows Live Mail Converter with which this License 

is included, you may return the complete package unused without requesting an activation key 

within 30 days after purchase for a full refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed 

Copy of Stellar DBX To Windows Live Mail Converter. For purposes of this License, if you have a 

valid single-user license, you have the right to use a single Licensed Copy of Stellar DBX To 

Windows Live Mail Converter. If you or your organization has a valid multi-user license, then you 

or your organization has the right to use up to a number of Licensed Copies of Stellar DBX To 

Windows Live Mail Converter equal to the number of copies indicated in the documents issued by 

Stellar when granting the license. 

 

Scope of License 

Each Licensed Copy of Stellar DBX To Windows Live Mail Converter may either be used by a 

single person or used non-simultaneously by multiple people who use the software personally 

installed on a single workstation. This is not a concurrent use license. 

All rights of any kind in Stellar DBX To Windows Live Mail Converter, which are not expressly 

granted in this license, are entirely and exclusively reserved to and by Stellar Information 

Systems Ltd. You may not rent, lease, modify, translate, reverse engineer, de-compile, 

disassemble or create derivative works based on Stellar DBX To Windows Live Mail Converter 

nor permit anyone else to do so. You may not make access to Stellar DBX To Windows Live Mail 

http://www.stellarinfo.com/
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Converter available to others in connection with a service bureau, application service provider or 

similar business nor permit anyone else to do so. 

 

Warranty Disclaimers and Liability Limitations. 

Stellar DBX To Windows Live Mail Converter and all accompanying software, files, data and 

materials are distributed and provided AS IS and with no warranties of any kind, whether 

expressed or implied. You acknowledge that good data processing procedure dictates that any 

program including Stellar DBX To Windows Live Mail Converter must be thoroughly tested with 

non-critical data before there is any reliance on it and you hereby assume the entire risk of all use 

of the copies of Stellar DBX To Windows Live Mail Converter covered by this License. This 

disclaimer of warranty constitutes an essential part of this License. 

In addition, in no event does Stellar authorize you or anyone else to use Stellar DBX To Windows 

Live Mail Converter in applications or systems where its failure to perform can reasonably be 

expected to result in a significant physical injury or in loss of life. Any such use is entirely at your 

own risk and you agree to hold Stellar harmless from any and all claims or losses relating to such 

unauthorized use. 

In no event shall Stellar Information Systems Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages 

for loss of business profits, business interruption, loss of business information, or any other 

pecuniary loss) arising out of the use of or inability to use the software product or the provision of 

or failure to provide support services, even if Stellar Information Systems Limited has been 

advised of the possibility of such damages. In any case, Stellar Information Systems Limited’s 

entire liability under any provision shall be limited to the amount actually paid by you for the 

software product. 

 

General 

This License is the complete statement of the agreement between the parties on the subject 

matter and merges and supersedes all other or prior understandings, purchase orders, 

agreements and arrangements. This License shall be governed by the laws of the State of Delhi, 

India. Exclusive jurisdiction and venue for all matters relating to this License shall be in courts and 

fora located in the State of Delhi, India and you consent to such jurisdiction and venue. There are 

no third party beneficiaries of any promises, obligations or representations made by Stellar 

herein. Any waiver by Stellar of any violation of this License by you shall not constitute nor 

contribute to a waiver by Stellar of any other or future violation of the same provision or any other 

provision of this License. 

 

Copyright © 1995-2012 by Stellar Information Systems Ltd. INDIA 
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Trademarks 
Stellar DBX To Windows Live Mail Converter® is a registered trademark of Stellar Information 

Systems Ltd. 

 

Windows XP®, Windows Vista®, and Windows 7® are registered trademarks of Microsoft® 

Corporation Inc. 

 

All Trademarks Acknowledged. 

 

All other brands and product names are trademarks or registered trademarks of their respective 

companies. 
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FAQs 
1. What does the demo version of the software do? 

In demo version of the software, you can save five mails per folder. 

2. Can I convert a single mail into EML file? 

No.  

3. Can Stellar DBX To Windows Live Mail Converter search for a DBX file location of 

which is unknown to me? 

Yes, you can search for DBX file using Find option present in Select DBX File dialog 

box. for full detail, please refer Search DBX File topic of this help. 

4. Can I convert multiple DBX files simultaneously? 

Yes. But multiple DBX files should be in a single identity folder. Then you can select this 

identity folder for conversion. 

5. Can I convert multiple Identity Folders simultaneously? 

No.  

6. What is the default location of DBX file on my Windows XP system? 

The default location of DBX file on Windows XP system is -> C:\Documents and 

Settings\Administrator\Local Settings\Application Data\Identities\..... 
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About Stellar 
Stellar Information Systems Ltd. is a trusted name in the field of Data Recovery and Data 

Protection Software for more than a decade.  

 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery 

Software for almost all Operating Systems and File Systems. 

Product line:  

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after 

accidental format, virus problems, software malfunction, file/directory deletion, or even sabotage!. 

More Info >> 

 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office 

repair tools. More Info >> 

 

E-mail Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS 

Outlook Express and MS Exchange useful in instances of data loss due to damages and 

corruption of E-mail. More Info >> 

 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to 

ensure complete data protection against hard drive crash. More Info >> 

 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical 

drives, System Traces & Internet traces. Once the data have been removed using Stellar Wipe - 

Data File eraser utility, it is beyond recovery limits of any Data Recovery Software or utility. More 

Info >> 

For more information about us, please visit www.stellarinfo.com 

 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/undelete.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/file-eraser.htm
http://www.stellarinfo.com/file-eraser.htm
http://www.stellarinfo.com/
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